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Chapter

1
Introduction
This chapter introduces the purpose of this manual and
some guidel ines on using it, as well as expl aining what we
refer to as ‘integration’ in terms of introducing AutoDoc
HSE to your exis ting environment.
In real ity, AutoDoc HSE can be ‘dropped in’ to your
existing systems with minimal change required, but this
manual focuses on ge tting the most out of your
investm ent and therefore suggests some more advanced
configurations, the first of which is detail ed in this
chapter.
This chapter contains the following sections:


Purpose



Using this manual



AutoDoc HSE integration explained



Optimising Exonet for use with AutoDoc HSE
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Purpose
This manual is designed to provide a guide to demonstrate how you can get the
most out of AutoDoc HSE in common scenarios using MYOB Exonet. Using realworld examples with a step-by-step approach, you will use AutoDoc HSE’s main
features to configure your environment for effective document delivery.
This manual is intended to supplement the Reference Manual – there you will
find much more detail on how AutoDoc HSE works, and its specific functionality
– but users who prefer a more hands-on learning approach may find this manual
a more appropriate place to start.
Note also that this manual includes detail on how to configure Exonet Clarity
Report templates in tandem with AutoDoc HSE’s settings.
The examples given in this manual are only examples, and as you become more
experienced with AutoDoc HSE, you will think of different ways to configure
your system to achieve better results, more suited to your particular situation.

Using this manual
This manual is divided into four subsequent chapters, each focusing on a specific
example of setting up your environment to achieve a specified end result.
The examples used in this manual are:

ICON KEY
!

Important information

 Tip/useful information



Invoice delivery



Statement delivery



Stock Valuation report delivery



Marketing material delivery

Each example is designed to include the use of more (or more complex) AutoDoc
HSE features than the previous one. However, the Stock Valuation report delivery
example may also be of particular interest to a more novice Exonet user, as it
demonstrates how AutoDoc HSE can effectively deliver your Exonet reports
without making any change whatsoever to Exonet, or to the Clarity form used to
create the Stock Valuation report. This example achieves the end result simply by
adding AutoDoc HSE to your existing setup, and configuring AutoDoc HSE to
interpret the information Exonet already provides.
The more vital content in the manual is highlighted with an icon in the left
margin. The key to the left of this paragraph depicts a miniature version of the
icons used, together with a description of their meanings.
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Before you start - a ssumptio ns
This manual assumes that:
1.

You have installed the AutoDoc HSE application and performed the basic
post-installation tasks required to allow the application to communicate
with your fax service, e-mail provider and so-on (refer to our online
website resources or for details – www.streamlinesoftware.net).

2.

Microsoft Fax has been chosen (and installed) as the fax client. This is by
no means an essential step for successful use with Exonet - this is simply
the configuration used in these examples.

3.

You are familiar with Exonet configuration techniques and the basic SQL
syntax required to create and modify tables (but note that the chapter
devoted to Stock Valuation Reports, starting on page 40, is exempt from
this pre-requisite).

Conventions
The following conventions apply in this manual:


Filenames and file paths, drive letters, or text visible in on-screen fields
appear in the same font as used in the following example: C:\Program
files\AutoDoc HSE.



Any element of a text string that is not fixed, is denoted with ‘<>’ brackets,
as
in
the
following
example:
C:\Documents
and
Settings\<folder name>\<filename>.



When referring to an on-screen control such as a button or text field, the
name of the control appears in italics, as in the following example: Click
the Next button to continue.



Due to AutoDoc HSE being a Windows®-based application, frequent
reference to Microsoft® and its products is made in this manual. It is
acknowledged that the Microsoft name and the names of its products are
either registered trademarks or trademarks of Microsoft Corporation in
the United States and/or other countries.

AutoDoc HSE integration explained
AutoDoc HSE is a context-sensitive document delivery system. To achieve this
context-sensitivity, the AutoDoc HSE printer analyses the print job you send to it,
and reads any ‘textual commands’ you have specified in the source document.
To achieve successful delivery of your documents, there are two main
components you need to configure:
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1.

Document content (to supply AutoDoc HSE with the information it
needs), and;

2.

AutoDoc HSE settings (to enable AutoDoc HSE to recognise your
instructions and to interpret them as you wish).

Aligning these two components to achieve a specific result is what we refer to as
‘integration’.
The first component above (document content) can either be added manually, on
the fly, to documents you wish AutoDoc HSE to process (for example, in a
Microsoft Word document), or via pre-set means (for example, by adding fields to
a Clarity report). This manual focuses on the second of these means, and provides
step-by-step instructions on how to adjust existing Clarity reports so they include
the information needed to enable AutoDoc HSE to process them most effectively.

Optimising Exonet for use with AutoDoc HSE
A key concept of the AutoDoc HSE system is delivery method. AutoDoc HSE
supports the following delivery methods:


E-mail



Fax



Print (hard copy)



Archive (file storage)



SMS text message

The archive method is used for your organisation’s internal records, while the email, fax, print, and SMS methods can all potentially be directed to recipients
outside your organisation.



To ensure that the preferred delivery method is used for your external clients, we
recommend that you use Exonet’s ‘Extra fields’ functionality to create delivery
method options that AutoDoc HSE can use. In the examples in this manual, all the
external correspondence is directed to debtors, and we will therefore modify the
debtors database table to include a delivery method.

Note that the process defined in this section is also covered in our online web
presentation
(http://www.streamlinesoftware.net/Presentations.aspx)
called
“Exonet Initial Integration”.
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Creating an extra S QL table
A SQL script has been included in Appendix A of this manual. Please execute the
script against your Exonet SQL database (taking care to adhere to good change
control practice) to modify the database to include extra delivery method
information which will be used by AutoDoc HSE
HSE.

Creating the extra Exonet delivery me
e thod field
Perform the following steps to add extra fields to your Debtors view.
1.

Log in to your Exonet Configuration console.

2.

Navigate to the System | Extra Fields menu, and click on the New button:

3.

Create a new field using the DR_ACCS table, entering the information as
in Figure 1.
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FIGURE 1 – Adding a new field. The highlighted X_AD_DELIVERY entries were created
by running the script as per the Creating an extra SQL table section of this manual on page
8. Note that the Position (1-24): field entry of ‘1’ is acceptable in this example as the position
‘01’ is listed as ‘Not used’ in the column on the right. Your system may already have
position 1 occupied by a customised field, in which case you would need to locate and use
a vacant position for this new field. The tooltip field provides the means to supply an
optional tooltip to guid
guidee Exonet users regarding the purpose of the new field.

4.

AutoDoc HSE Exonet Integration

Save the new field and close the Exonet Configuration console.
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5.

Log in to the main Exonet console, and recall a debtor account. Within the
Debtor Account Details screen, check that your new field has been added:

FIGURE 2 – The Details 1 tab of the Debtor Account Details screen, showing the new
Autodoc
doc hse send as
as: field. Note again that since the field was added in position 1, which
may not be the case in your situation
situation, your new field may be on an entirely different tab.
tab
However, you should be able to find the field, and the field contents should allow for the
three delivery methods, Print/Mail, E-mail,
mail, and Fax.

Having completed this process, you are now ready to move on to configuring
AutoDoc HSE and Clarity to make use of this new field.

!

Note that you will also need to go through your customer records and specify
their preferred delivery methods, and ensure that an e-mail
e
address or fax
number has also been recorded for those customers for whom either
eithe of those
delivery methods has been specified as their preference.
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Chapter

2
Invoices
Invoices are one of the l east popul ar forms of
communication, so when del ivering them , effective,
meaningful , and accurate presentation is a must. This
chapter shows you how to achieve this with AutoDoc HSE,
at the same time as minimising the adminis trative
overhead on manual processes.
The goals for this exercise are to:





Configure your system to allow AutoDoc HSE to handle all your Exonet
invoices so your staff need not negotiate the fax machine or manually
create and send e-mails.



Ensure all invoices sent electronically from Exonet are personalised,
featuring an appropriate covering ‘letter’, including recipient’s name, and
key invoice information.



Ensure all invoices produced by Exonet are automatically, electronically
archived to a meaningful, standardised location.

Note that the process defined in this section is also covered in our online webpresentation
(http://www.streamlinesoftware.net/Presentations.aspx)
called
“Exonet Invoices”.
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Configuring the invoice Clarity report form
We will now modify the Clarity Report form that produces the invoice, to include
the information AutoDoc HSE will use. This involves:


Adding a new field to the template which will contain the customer’s email address or fax number, if these delivery methods have been specified
as the customer’s preferred delivery method;



Adding a new field to the template which will specify the AutoDoc HSE
form number to be applied to the delivery; and



Changing the font colour of existing invoice information, to allow
AutoDoc HSE to recognise that information.

New invoice field s
Perform the following steps:
1.

AutoDoc HSE Exonet Integration

Navigate to the Clarity Report designer, and open the Invoice form,
Invoice.clf (see Figure 3).
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FIGURE 3 - Opening the invoice form in Clarity.
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Figure 4 - The invoice form.
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3.

Move to the Data tab.

4.

In thee ‘Accs linked to Master’ query, use the ‘Fields’ toolbar button to open
the Query Designer:
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5.

In the Fields tab, add the new X_AD_DELIVERY field to the query - locate
it in the top Available Fields pane and double-click
click the entry to add it to the
end of the list in the bottom Selected Fields pane:

6.

Return to the Design view and add a string-type
type variable to the footer of
the invoice:

7.

Move to the ‘Calc’ tab, scroll the Report Objects pane to locate the new
variable in the footer, and single click the variable to rename it to
something more meaningful:

AutoDoc HSE Exonet Integration
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8.

AutoDoc HSE Exonet Integration

Select the ‘OnCalc’ event and change the blank event code to match the
code depicted in the screenshot below (also available in Appendix A).
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9.

Return to the Design view, and using
sing the font colour pull-down
pull
list, set
the text colour for the field to white. This
his makes the resultant text (whether
it is a fax number or e-mail
mail address) recognisable to AutoDoc HSE as a
textual command, and hides it from the user.

Note that if the debtor’s delivery method is ‘Print/Mail’ (or if an unknown value is
passed through to the variable), the variable will simply print with no value,
v
just
blank. This will result in AutoDoc HSE then processing the print job on an
‘exception
exception’ basis, since no fax number or e-mail
mail address would be found. This
exception basis is allowed for in the configuration we perform in step 3 on page
27.
10. Add a plain text label to the footer of the report:

11. This label should have the value ‘2’, which will correspond to AutoDoc
HSE’s form #2:

AutoDoc HSE Exonet Integration
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!

To ensure the “2” text in this label is differentiated from the font used in the
AutoDocHSEDeli
AutoDocHSEDelivery
very field we added, one of font, font size, font colour, or font
style, must be different to distinguish the two new fields, and since the font colour
must be white for both fields (in order for AutoDoc HSE to ‘see’ them), change the
font, font size, or font style. If this step is not performed, AutoDoc HSE may find
(for example) the string 2123456 instead of the two separate strings: the form
number 2, and fax number 123456.

12. Ensure the font colour is set to white, and then change the font of the label
to prevent it being ‘joined’ to the AutoDocHSEDelivery field when the
print job is processed:

Making invoice inf ormatio n available to AutoDoc HSE
To make existing invoice information available to AutoDoc HSE, perform the
following steps:
1.

AutoDoc HSE Exonet Integration

Select the report field labelled Label 2.. This label prints the Account
Namee to which the invoice applies. Change the font colour of this field to
RGB 2,2,2. This is achieved by using the font colour pull-down
pull
list, and
then selecting the More Font Colors… option, and entering 2,2,2 into
the Red, Green, and Blue fields respectively:
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This change will result in AutoDoc HSE storing the account name for the invoice
as variable 22, as defined in AutoDoc HSE’s Variables tab for form number 2.
2.

Perform a similar change to the report field called Invoice Text.
Text This is the
field that produces,
uces, for example, the text string ‘Tax Invoice 1038’. The font
colour of this field needs to be changed to RGB 1,1,1, to allow AutoDoc
HSE to recognise and store it as variable 1.

3.

Similarly, the report field called Transdate needs to be changed to RGB
3,3,3, and the field called Accno needs to be changed to RGB 4,4,4.
4,4,4

4.

Save your changes.

Configuring AutoDoc HSE for invoices
Now that the Clarity invoice has been configured to include a delivery command
(an e-mail
mail address or fax number, or nothing), a form number, and some
‘coloured’ text, AutoDoc HSE needs to be configured to recognise, and use, that
information.

Configuring v
variables
Launch AutoDoc HSE and perform
erform the following steps in AutoDoc HSE’s
Variables tab
tab, within the Form templates setup area:
1.

Increment the Form # field to form number 2,, and then change the form
name to invoice:

2.

Change the first four variables’ names to match the screenshot below.
These variables will capture the information from the fields on which the
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RGB values were changed in the section called “Making
“
invoice
information available to AutoDoc HSE”, on page 19.

This configuration will now result in AutoDoc HSE storing the ‘coloured’
information from the Clarity invoice, using the variable names specified above,
since the Clarity invoice has RGB values matching the RGB values
val
for variables
defined
d ((see Figure 5 below).

FIGURE 5 – The relationship between fields on the Clarity invoice, and AutoDoc HSE
variables. For example, the Clarity field “Transdate” has been coloured RGB 3,3,3,
3,3 which,
according to the variables definition in AutoDoc HSE, will result in the variable called
“dated” being populated with the transaction date printed on the invoice.
3.

AutoDoc HSE Exonet Integration

Apply your changes using the Apply button.
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Configuri
Configuring e-mail
1.

Move to AutoDoc HSE’s E-Mail tab. Add a subject heading to the Subject
field, so it reads as %Document ID%
% for %Company Name%.
Name% This will
create a convenient reference for your clients, and would allow them to
sort their Inbox by subject heading to find a specific invoice number to
locate the associated e-mail.

2.

Enter the text that will be used as the body of the e-mail
mail in the Message text
field, so the message reads as follows:

Please find attached %D
%Document ID%,
%, dated %Dated%, for
Account No: %Account Number%. If you have any queries
regarding this invoice, please contact me on the number
below.
Kind r
regards,

%fullname%
name%

Ph. %officephone%
officephone%
Fax. %
%faxnumber%

AutoDoc HSE Exonet Integration
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Note that while we defined the new var
variable
iable on the Variables tab as ‘document
‘d
id’,’, we have referred to it here as ‘%
‘%Document ID%’ – enclosing the text in the ‘%’
character signifies that we are referring to a variable and,
and as seen here, variable
names are not case
case-sensitive.

3.

While we now have the basis for an informative e-mail
ail message, we could
give it more flair. The following simple example uses the HTML-rich
functionality to format the message and,, for the sake of convenience for
the exercise, adds the AutoDoc HSE enterprise logo from the Streamline
website:

<html><body>
<font face="Trebuchet MS">
<p>Please find attached %Document ID%, dated %dated%, for account no: %account
number%.

If you have any queries regardin
regarding
g this invoice, please don't hesitate

to contact me on the number below.</p>
<p>Kind regards,</p>
<p>%fullname%.</p>
<p>Ph: %officephone%</p>
<p>Fax: %faxnumber%</p>
</font>
<table><tr><td>
<img src=http://www.streamlinesoftware.net/images/ADHSE_enterprise
http://www.streamlinesoftware.net/images/ADHSE_enterprise_50.gif>
http://www.streamlinesoftware.net/images/ADHSE_enterprise
</td></tr></table>
</body></html>
There are several alternatives for using HTML, images, and file attachments. See
the Reference Manual for more details on AutoDoc HSE’s e-mail
e
functionality.
4.

AutoDoc HSE Exonet Integration

Change the E-Mail address overrule field entry to CREATOR/OWNER.
CREATOR/OWNER This
will ensure that while you are in the process of testing your configuration,
any e-mails
mails created will have their recipient addresses overruled by that of
the person who sent the print job to AutoDoc HSE.. That is, any e-mails
e
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generated by AutoDoc HSE will stay within your organisation,
organi
for testing
purposes.

5.

Apply your changes.

Configuring ffax
1.

Move to AutoDoc HSE’s Fax tab. Enter the %company name% variable
and a subject heading to: %document id% from <your company
name>:

2.

Note the Cover page field has been populated with a default generic
entry. You can click on the Cover Page Designer button to launch the
Microsoft Fax cover page editor to edit this generic file, or just use the
Cover page drop down list to choose a different cover page:

AutoDoc HSE Exonet Integration
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The fax cover page’s Recipient’s Name (‘To’) field will be populated by the
merged contents of AutoDoc HSE’s Company Field and Attn Field fields.
3.

Add the following text to AutoDoc HSE’s Cover page text contents:

Please find following %document id%, dated %Dated%, for Account
No: %Account Number%.
Kind regards,
%fullname%.
name%.

4.

Again, for the sake of testing, choose to overrule the fax recipient number
with the fax number of the user who creates the invoice:
invoice

5.

Apply your changes.

Configuring a
arc hiv e backups and ha rd copies
opies
1.

Move to AutoDoc HSE’s PDF/TIF Archive tab. Enter a file path and file
name to which a copy of the invoice will be saved. In this case, we will use
a local file path (the preferred option),, but a network location could also be
used.

C:\Archives
Archives\Clients\%company name%\invoices\%document
%document id%.pdf

AutoDoc HSE Exonet Integration
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2.

Ensure the Use letterhead checkbox is cleared (this results in any letterhead
specified on the Letterheads tab being excluded from the archive copy, to
reduce file size), and ensure that the Overwrite PDF checkbox is also
cleared. This
his ensures that the archive file will not be overwritten by a
future archive, but rather, any future archive of the same filename would
be appended to the first. In the archive path we created,
overwriting/appending is not likely to be an issue, as invoice IDs would be
unique.

3.

Move to the AutoDoc HSE Print page. In the Reduced Printer Output tab,
tab
check the [Print to User printer #1] checkbox.. This will ensure
ensur that if the
invoice is for a client who prefers to receive their invoice by post, a hard
copy will be produced on the Exonet user’s usual printer of choice. If the
client in question is sent the invoice via e-mail
mail or fax, no hard
har copy is
produced as a result of this option.

4.

Apply your changes.

Configuring othe r AutoDoc HSE info
nfo rma tion
Several of the settings we have specified so far in this chapter have referred to
user
ser information. For example, we have elected to override recipient
reci
e-mail
addresses with the address of the user who created the invoice, and we have just
AutoDoc HSE Exonet Integration
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opted to print hard copy invoices to the user’s printer of choice. We therefore
need to define at least one AutoDoc HSE user.
1.

Move to AutoDoc HSE’s Users tab, located
ated in the Global setup area (you
will need to go to the home page to make the Global setup button
available).

2.

Use the ‘+’ button to open a new record. Create an AutoDoc HSE user for
at least one person who will test your AutoDoc HSE configuration,
completing,
ting, as a minimum, the following fields: User name (select a
Windows login name from the drop down list);; Full name; E-Mail
E
address;
Fax number; Office Phone; and User Printer #1.

FIGURE 6 - An example User entry, with the minimum information needed to test the
configurations used in this manual.

3.

Apply your changes.

You can now test your configuration by printing an Exonet invoice to AutoDoc
HSE!
AutoDoc HSE Exonet Integration
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Chapter

3
Statements
Automating a batch process such as a Statement run is
when AutoDoc HSE reall y pays dividends. Send a
statemen t run to AutoDoc HSE and l et it sort and perform
the del iveries for you – a hundred for fax, a few hundred
for e-mail , and fifty for hardcopy...
The goals for this exercise are to:


Configure your system to allow AutoDoc HSE to handle all your Exonet
statements seamlessly behind the scenes.



Ensure all statements sent electronically from Exonet are personalised,
automatically, featuring an appropriate covering ‘letter’, including
recipient’s name, and key aged balance period information.



Ensure all statements produced by Exonet are automatically, electronically
archived to a meaningful, standardised location.
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Configuring AutoDoc HSE for statements
Configuring v
variables
Perform the following steps in AutoDoc HSE’s
’s Variables tab (in the form
templates setup area)
area):
1.

In form #2, choose 05 in the Copy to field, to overwrite all of form #5’s
settings with those set up in form #2:

2.

Move to form number 5, and change the form name to Statement:

3.

Change the names for variables 14 through 17 to Current Balance, 1
Month Balance, 2 Month Balance, 3+ Month Balance,
Balance as
follows:

4.

Leave the remaining variables as they are and apply your changes.
changes

Configuring e
e-mail
1.

Move to AutoDoc HSE’s E-Mail tab. Add the subject heading
%formname% from %company% for %company name%:

The var
variable %company% is a pre-defined
defined system variable, which is populated by
the company name specified for the AutoDoc HSE user under the profile of whom
the print job is sent to AutoDoc HSE.. The variable %formname% is also a system
variable, and is populated with the name of the form under which the print job is
processed (in this case, it will be populated with “Statement”).
AutoDoc HSE Exonet Integration
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2.

We will now make use of the new ‘balance’ variables created for form 5,
by adding a balance summary to an e-mail message. Add the following
text:

Please find attached a copy of your Statement dated %dated% for
Account No: %Account Number%.
Your summary balances are as follows:
3+ Months: %17%,
%14%.

2 Months: %16%,

1 Month: %15%,

Current:

Should you have any queries regarding your account, please
don’t hesitate to contact me on the number below.
Kind regards,
%fullname%
%title%.
Ph: %officephone%
E-mail:
www.corporatebloom.com.au

%emailaddress%

Internet:

Alternatively, the e-mail message could be created as an HTML message,
complete with a tabulated balance summary, as in Figure 7.
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Figure 7 – Showing the use of variables in an HTML table, and how
ho the plain text translates
to HTML. The text that currently states “%3+ month balance%” will be dynamically
translated to the debtor’s 33+ month dollar value balance when the e-mail
e
is created. The
HTML
ML used for this example is available in Appendix C.

3.

Ensure the E-Mail address overrule field entry to CREATOR/OWNER,
CREATOR/OWNER to
ensure that the resultant e-mails
mails are directed internally for testing
purposes. Under this setting, the user who prints the statement will be the
recipient of the resultant e-mail.

4.

Apply your changes.

Configuring ffax
1.

Move to AutoDoc HSE’s
’s Fax tab. Change the subject heading to:
Statement from %company%.

2.

Add the new variables to the Cover page contents:

Please find following your
Account No %Account Number%.

Statement,

dated

%Dated%,

for

Your summary balances are as follows:
3+ Months: %17%
AutoDoc HSE Exonet Integration

Chapter 3: Statements

32 of 54
Document: ©2008 mr office
www.mroffice.biz

2 Months:

%16%

1 Month:

%15

Current:

%14%

Kind regards,
%fullname%.
name%.
3.

Again, for the sake of testing, choose to overrule
verrule the fax recipient number
with the fax number of the user who creates the statement:
statement

4.

Save your changes.

Configuring
onfiguring a
arc hiv e backups and ha rd copies
opies
1.

Move to AutoDoc HSE’s PDF/TIF Archive tab. Remove the invoice
archive path which was copied from form 2 to our current form, form 5,
and enter a file path and file name to which a copy
py of the statement will be
saved:

C:\Archives
Archives\Clients\%company name%\statements\
\%dated%.pdf
2.

Check the Overwrite PDF checkbox. This will result in the first statement of
this filename and location being overwritten by any subsequent statement
which has the same filename. Effectively, given the particular path and
filename specified, this means that if you produce more than
t
one
statement for the same client, with the same statement date, only the most
recent will be retained.

3.

Add a second archive path:

C:\Archives
Archives\Clients\%company name%\statements\
\running.pdf
4.

Ensure the Overwrite PDF checkbox on this second path is cleared:

Figure 8 – Showing two archive paths. The ‘%dated%.pdf’ filename will produce a separate
PDF file for every statement produced. The ‘running.pdf’ filename, together with the
cleared Overwrite PDF checkbox, will result in a PDF file for each client, which grows each
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time a statement run is performed. This file will be an accumulation of all the statements
ever produced for the client.

5.

Move to the AutoDoc HSE Print page. In the Reduced Printer Output tab,
check the [Print to User printer #1] checkbox.. This will ensure that, once we
have modified the Clarity Statement report, if the statement is for a client
who prefers to receive their statement by post, a hard copy will be
produced on the Exonet user’s usual printer of choice. If the client in
question is sent the statement via e-mail or fax, no hard copy is produced
as a result of this option.

6.

Apply your changes.
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Configuring the Statement Clarity Report form
orm
We will now modify the Clarity Report form that produces the statement, to
include the information AutoDoc HSE will use.
1.

Navigate to the Clarity Report designer, and open the Statement form,
statement.clf.

2.

Move to the Data tab.

3.

In the ‘master’ query, open
en the query designer using the Fields toolbar
button:

4.

Locate the X_AD_DELIVERY field in the Available Fields pane. Doubleclick on the entry to add this field to the Selected Fields pane.
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5.

Also add
dd both the FAX and EMAIL fields (also from the DR_ACCS table)
to the Selected Fields pane by locating them in the Available Fields list and
double clicking:

6.

In the Design tab, add
dd a plain text label to the footer, assign the text ‘5’ (to
correspond to AutoDoc HSE’s
’s form #5 for statements), and change the
font’s colour to white:
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7.

Add a string-type variable to the footer:

8.

In Report Objects pane of the Calc tab, locate the new variable in the footer
and rename it to ‘AutoDocHSEDelivery’:

9.

Add the following code to the variable’s OnCalc event (the code is also
available in Appendix C):
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10. Using the font colour pull-down list (as in step 6), set the text colour for
the field to white. This makes the resultant text (whether it is a fax number
or e-mail address) recognisable to AutoDoc HSE as a textual command,
and hides it from the user. Note that if the debtor’s delivery method is
‘Print/Mail’ (or if an unknown value is passed through to the variable), the
variable will simply print with no value, just blank. This will result in
AutoDoc HSE then processing the print job on an exception basis, since no
fax number or e-mail address would be found. This exception basis was
allowed for in the configuration we performed in step 5 on page 34.

!

11. Change the font used for the variable text, to ensure it is differentiated
from the font used in the label (‘5’) added in step 6 on page 36. One of:
font; font size; font colour; or font style, must be different to distinguish
the two new fields, and since the font colour must be white (in order for
AutoDoc HSE to ‘see’ it), change the font, font size, or font style. If this step
is not performed, AutoDoc HSE may find (for example) the string
5123456 instead of the two separate strings: the form number 5, and fax
number 123456.
12. Because we have used the following list of other user-defined variables to
construct our AutoDoc HSE e-mail, fax, and archive information, we need
to also change the font colours of the equivalent report fields to allow
AutoDoc HSE to recognise and store their content, according to their
AutoDoc HSE RGB configurations (as defined on the Variables tab for
form 5):


%company name% (RGB 2,2,2)



%dated% (RGB 3,3,3)



%account number% (RGB 4,4,4)



%current balance% (RGB 14,14,14)



%1 month balance% (RGB 15,15,15)



%2 month balance% (RGB 16,16,16)



%3+ month balance%. (RGB 17,17,17)

See Figure 9 on page 39.
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FIGURE 9 - Statement fields configured with RGB values to populate AutoDoc HSE
variables.

13. Save your changes.
Both AutoDoc HSE and the standard Clarity form for statements have now been
configured to allow AutoDoc HSE to process statements produced by Exonet.
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Chapter

4
Stock Valuation Reports
Stock Val uation Reports provide a useful exampl e of how
AutoDoc HSE can be used to keep your ow n staff
informed of your organisation’s position. This example al so
demonstrates how AutoDoc HSE can be ‘dropped in’ to
your exis ting system, achieving effective and powerful
document del ivery without making a singl e configuration
change to your existing software.
The goals for this exercise are to:


Configure your system to create a Stock Valuation Report each week and
e-mail it to key internal staff.



Use the Clarity filename as the trigger for AutoDoc HSE actions, ensuring
key staff see the report each time it is produced through AutoDoc HSE.

Note that there are no configuration changes made to the Clarity Stock Valuation
form for this example.
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Configuring AutoDoc HSE for stock valuation
aluation reports
Configuring commands
Perform the following steps in AutoDoc HSE’s Form independent translations
setup area.

1.

Create a translation entry, with field contents of STLStkValue.clr,
STLStkValue.clr
Red/Green/Blue settings of 0,0,128 and command translation of 9:

Having made this entry, if we were to save AutoDoc HSE’s
HSE settings at this point
and direct a print job to the AutoDoc HSE printer, the job would be assessed to
determi
determine whether there are any text strings equal to ‘STLStkValue.clr
STLStkValue.clr’ in the
document, with RGB values of 0,0,128.
8. If such a string is found, AutoDoc HSE
will treat that string as being equivalent to a textt string ‘9’ in RGB 255,255,255 (i.e.
a form number).
Because Exonet includes the report filename in the footer of its reports (in
coloured text with RGB values 0,0,128)
0,0,128),, this will result in the Stock Valuation
Report (filename = STLStkValue.clr) being processed by form 9,
9 if sent to an
AutoDoc HSE printer. Such
uch a ‘translation’ of existing text allows us to achieve
‘virtual’ report configuration in lieu of actually adding a form number to the
Clarity report.
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!

Note that when making a Field contents entry in the translation table, strings are
case
case-sensitive. That is, the entry made in the Field contents column must be exactly
as it will appear in the source document from which the print job is created.

2. Add another translation, with field contents of STLStkValue.clr,
STLStkValue.clr
RGB settings of 0,0,128, and the command translation of
grace@corporatebloom.com.au

Assuming Grace is the general manager of the organisation,
ation, this configuration
will result in any Stock Valuation Report printed to an AutoDoc HSE printer
being ee-mailed
ed to the general manager under whatever settings are specified in
AutoDoc HSE form 9 – without changing anything in the default Clarity Stock
Valuation report.
3.

Apply your changes.

Configuring e
e-mail
1.

Move to the E-mail tab (in the Form templates setup area), and select form
9. Enter a description for the form to make its purpose obvious in all tabs:

This name will also be used as the filename of the ee-mailed
ed PDF attachment of the
report, unless you specify a different nam
name in the Display Name field.
2.

Elect to send a CC e-mail
mail to the user who is responsible for ensuring the
general manager receives the stock valuation report. This will ensure that
this user receives a copy along with the manager:

3.

Add a meaningful e-mail subject (you
you may wish to add the fact that the email is automatically generated) and e-mail text.
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4.

Change the Send mail using user profile setting to the name of the user
responsible for the weekly report. This ensures that the general manager
can simply use the ‘reply’ e-mail button if she
he wishes
wishe to communicate
with that user, even if, for example, the print job is actually scheduled as
an automated task from a certain PC at a set time each week.

5.

Because the Stock Valuation report is being sent to an internal
int
address,
you may be comfortable not using a testing ‘overrule’ for this exercise.

6.

Apply your changes.
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Chapter

5
Marketing Attachments
I f you are al ready e-mail ing something to your cl ients (for
exampl e, an invoice or statement), why not make the
most of the opportunity and incl ude a current, tailored l ist
of special s?
The goals for this exercise are to:


Attach an additional file in an invoice e-mail, via command translation.



Ensure the file (a list of specials) is relevant to the customer to whom the
invoice is addressed.

Note that this exercise builds on the configuration detailed in Chapter 2.
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Configuring AutoDoc HSE for invoice marketing
arketing
1.

Move to AutoDoc HSE’s Form independent translations setup area.
area

Note that the two translation table entries depicted above may not exist in your
AutoDoc HSE configuration – these were added as part of the exercise in chapter
4.. Their presence, or absence, will not affect the outcome of this exercise, since
both these tr
translations
anslations are based on the string ‘STLStkValue.clr’
‘STLStkValue
(the filename of
the Stock Valuation report), which will not appear in an invoice print job.
2.

Add the following two translations:

RETAIL

250, 250, 250

c:\marketing
marketing\retail\specials.pdf

TRADE

250, 250, 250

c:\marketing
marketing\trade\specials.pdf

!

Note that when making a Field contents entry in the translation table, strings are
case
case-sensitive. That is, the entry made in the Field contents column must be exactly
as it will appear in the source document from which the print job is created. In this
case, the sales group names are all capitals, so we need to define them within
AutoDoc HSE as all capitals also, or AutoDoc HSE will not recognise them in the
report.

3.
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Configuring the invoice
nvoice Clarity Report form for
marketing
We will
ill be making use of Exonet’s Debtor Sales Primary Group field for this
example. Two of the three possible options (foreign, retail,
etail, and trade) for this
group in this example, are used as the translation ‘triggers’ which we configured
in AutoDoc HSE
HSE.
Our example company, Corporate Bloom, treats non
non-corporate
corporate clients as retail,
while the bulk discounts applying to corporate clients are treated as trade.

1.

AutoDoc HSE Exonet Integration

Open the Clarity invoice form, invoice.clf. If you have not already
performed the Invoice exercise in Chapter 2,, your invoice footer will not
include the two highlighted fields below, and you will need to complete
that exercise before the configuration in this chapter
hapter can take effect.
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2.

From the Data tab, open the query designer from within the ‘Accs linked
to Master’ query, and locate and add the ‘DR_ACCGROUPS’ table (within
the Table tab) to the query (by double-clicking
clicking on the entry),
entry) and create an
inner join between the DR_ACCGROUPS and DR_ACCS tables as
a per
Figure 10. After clicking the OK button on the Join Table dialog, leave the
Query Designer open for the next step.

FIGURE 10 - Creating an inner join between DR_ACCGROUPS.ACCGROUP and
DrAccs.ACCGROUP.

AutoDoc HSE Exonet Integration

Chapter 5: Marketing Attachments

47 of 54
Document: ©2008 mr office
www.mroffice.biz

3.

Move to the fields tab of the query designer, and add the GROUPNAME
field to the report:

4.

Move back to the Design tab and add a ‘DBText’-type
type field to the footer.
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5.

Link the new DBText field to the Accs table and GROUPNAME field:

6.

Change the font of the DBText field, and then the font colour to RGB 250,
250, 250.

We have now configured both AutoDoc HSE and the Clarity report form to allow
‘tailored’
ed’ delivery of sp
specials lists.
The primary sales group of the debtor will now be included in the footer of each
invoice, in ‘not quite white’ text, which is invisible to the user, but for which
AutoDoc HSE will search in order to identify a translation command. Depending
on
n which group name is included in the invoice, AutoDoc HSE will attach the
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appropriate specials list for that group (as defined in AutoDoc HSE’s
HSE Commands
tab).
Note that you will need to ensure that appropriate files do exist in the locations
specified in the form independent translations setup in order for this example to
work effectively.

FIGURE 11 – an example of an e-mail created and sent by AutoDoc HSE,
HSE as a result of an
Exonet user printing an invoice. The invoice subject heading and message text are
constructed dynamically (this configuration was performed in the exercise in Chapter 2),
and the invoice itself is attached as a PDF file. This chapter has extended the exercise to
include the automatic attachment of an additional ‘Specials’ list. In this example, the debtor
is a retail client (as specified using Exonet’s sales groups
roups fields), and AutoDoc HSE
therefore attaches the appropriate retail price specials.
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Appendix A
The SQL script used to modify the Exonet SQL database is below. The script can be copied and pasted into
SQL Server’s script window, and edited according to your needs. The script performs three broad tasks:
1.

Creates a new reference table called “X_AD_DELIVERY” (extra AutDoc HSE Delivery) and populates
it with three delivery methods. Execute this part of the script if users will record a preferred delivery
method for debtors or creditors, or both (since an Exonet “extra field” drop down list will use this
reference table as a lookup data source to populate the new fields created in 2 and 3).

2.

Adds a new field called “X_AD_DELIVERY” to the existing CR_ACCS table, which will allow users to
store a preferred document delivery method for outgoing documents to suppliers. By default, the
preferred delivery method is set to hard copy. If your users don’t wish to record a preferred delivery
address for creditors (i.e. if they will not be using AutoDoc HSE to deliver outgoing documents such as
Purchase Orders), remove this part of the script.

3.

Adds a new field called “X_AD_DELIVERY” to the existing DR_ACCS table, which will allow users to
store a preferred document delivery method for outgoing documents to customers. By default, the
preferred delivery method is set to hard copy. If your users don’t wish to record a preferred delivery
address for debtors (i.e. if they will not be using AutoDoc HSE to deliver outgoing documents such as
Invoices), remove this part of the script.
CREATE TABLE X_AD_DELIVERY(SEQNO INT NOT NULL,[DESCRIPTION]
VARCHAR(50))
GO
INSERT INTO X_AD_DELIVERY(SEQNO, [DESCRIPTION]) VALUES ('0',
'Print/Mail')
INSERT INTO X_AD_DELIVERY(SEQNO, [DESCRIPTION]) VALUES ('1',
'Email')
INSERT INTO X_AD_DELIVERY(SEQNO, [DESCRIPTION]) VALUES ('2',
'Fax')
GO
ALTER TABLE CR_ACCS ADD X_AD_DELIVERY INT DEFAULT (0)
GO
UPDATE CR_ACCS SET X_AD_DELIVERY = 0
GO
ALTER TABLE DR_ACCS ADD X_AD_DELIVERY INT DEFAULT (0)
GO
UPDATE DR_ACCS SET X_AD_DELIVERY = 0
GO

While you can, of course, use an alternative table/field name (i.e. something other than “X_AD_DELIVERY”),
be aware that our Exonet integration guidance information assumes this name has been used, and as such,
refers to it frequently.
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Appendix B
The code used to define the ‘AutoDoc HSE’ variable added to the Invoice Clarity
Report is listed here.

begin
Case Accs['X_AD_DELIVERY'] of
0 : Value := '';
1 : Value := Accs['Email'];
2 : Value := Accs['Fax'];
else Value := '';
end;
end;
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Appendix C
The code used to define the ‘AutoDoc HSE’ variable added to the Statement
Clarity Report is listed here. The HTML code used to produce the AutoDoc HSE
e-mail in the Statement example (Figure 7 on page 32) is also included below for
your own use/modification.
Clarity Report code:
begin
Case master['X_AD_DELIVERY'] of
0 : Value := '';
1 : Value := master['Email'];
2 : Value := master['Fax'];
else Value := '';
end;
end;

AutoDoc HSE e-mail HTML:
<!DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta content="text/html; charset=ISO-8859-1" httpequiv="content-type">
<title>ExonetStatement</title>
</head>
<body>
<span style="font-family: Century Gothic;">Please find attached
a copy of your Statement dated %dated%, for account no: %account
number%.</span><br>
<br>
<span style="font-family: Century Gothic;">Your summary
balances are as follows:</span><br>
<br>
<table style="text-align: left; width: 100px; font-family:
Century Gothic;" border="1" cellpadding="2" cellspacing="2">
<tbody>
<tr>
<td style="font-weight: bold;">3+ Months</td>
<td style="font-weight: bold;">2 Months</td>
<td style="font-weight: bold;">1 Month</td>
AutoDoc HSE Exonet Integration

53 of 54
Document: ©2008 mr office
www.mroffice.biz

<td style="font-weight: bold;">Current</td>
</tr>
<tr>
<td>%3+ month balance%</td>
<td>%2 month balance%</td>
<td>%1 month balance%</td>
<td>%current balance%</td>
</tr>
</tbody>
</table>
</body>
</html>
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